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What This Manual Covers 
The Blackrock Central Software Suite serves three primary functions: 

1. Configuring hardware settings on the Cerebus and CerePlex Direct Neural Signal 
Processors.  

2. Visualizing continuous signals and sorted spikes in real time. 
3. Saving experimental data including continuous signals (.nsx) and digital events (.nev). 

System Description 

The flow of data through the Blackrock Data Acquisitions system begins with a 
biopotential of interest. Potentials are acquired by an electrode well suited to the signal 
and location being recorded. Acquired signals are buffered, amplified, and digitized by 
Blackrock headstages. Finally, data is processed, visualized, and saved by the Central 
Software Suite utilizing a Blackrock Neural Signal Processor. The system can perform 
real-time signal processing algorithms including: noise cancellation, digital filtering, 
simultaneous extraction of spike and field potentials, manual and automatic online spike 
sorting.  

Minimum System Requirements 

Microsoft Windows 7 Professional or Windows 10 Professional  

AMD or Intel 2.0 GHz Quad Core CPU 

4 GB of RAM 

1GHz Ethernet adapter 

1 TB 3 Gbit/s SATA II HDD 

 

A Host PC that is configured and tested by our engineers is available. Please contact 
sales@blackrockmicro.com for more information. 

Setup 

Installing Central Software Suite 

1. Uninstall any previously existing versions of Central Suite through 
Programs and Features in Windows Control Panel. 

2. Run the Central Suite installer (.msi) from the installation CD or 
Blackrockmicro.com. 

3. Install the MATLAB Compiler Runtime from the supplied installation CD or 
Blackrockmicro.com. 

Blackrock recommends that a dedicated PC be used to run Central. Refrain from 
installing any additional software or connecting the PC to the internet.  
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Configuring an Ethernet Port 

The Blackrock Neural Signal Processor communicates with a host PC over the 
UDP Ethernet protocol. Before installing the Central Software Suite, configure the 
Ethernet connection as shown below. 

Note: If you purchased the Blackrock Host PC, an Ethernet card is pre-installed 
and configured in your PC. 

1. Click on Start and search for ñView Network Connectionsò. 
2. Right click on the correct Ethernet Adaptor, usually Local Area 

Connection, and click on Properties. 
3. Uncheck all services except for Internet Protocol (TCP/IP) or Internet 

Protocol Version 4 (TCP/IPv4). 
4. Click on Internet Protocol (TCP/IP) and click on Properties. 
5. Set IP Address to 192.168.137.1 and Subnet Mask to 255.255.255.0 

Leave all other fields blank. 
6. Click on OK to save changes. 

 

  

 
Figure 1 ð Network Connections Window 
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Connecting Multiple PCs to One NSP 

A single Neural Signal Processor can connect to up to 16 PCs running the 
Central Software  

1. Connect the NSP and all PCs to a 1-Gbps network switch which has QoS 
enabled. 

2. Configure each PC as per instructions above, however, IP addresses 
should increment like so: 192.168.137.2, 192.168.137.3, etc. 

Note: For your reference, the NSPôs IP address is 192.168.137.128. 

Connecting Two NSPs to One PC 

A single PC can connect to two NSPs by running two instances of Central.  

3. 1Connect both NSPs to separate Ethernet ports on the PC. 
1. Follow the Configuring an Ethernet Port instructions, for both ports. 
2. Use an IP address of 192.168.137.17 for the second port. 
3. Navigate to the Central executable found in Program Files > Blackrock 

Microsystems. 
4. Create a shortcut to the Central executable. Right click the shortcut and 

edit the Target field to read: "C:\Program Files (x86)\Blackrock 
Microsystems\Cerebus Windows Suite\Central.exe --network 
inst=192.168.137.128 --network central=192.168.137.17 --instance 1 

5. Edit the shortcut name to indicate its connection to the second NSP.   
 

 
Figure 3 ð Local Area Connections 

 
 

 
Figure 2 ð IPv4 Properties 
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Central 
Central can be run from the desktop shortcut, the Start menu shortcut, or by navigating to the 
executable in the Blackrock Microsystems directory in Program Files. The Central main 
application connects to a Blackrock Neural Signal Processor to configure hardware channels 
and acquire data. Incoming data can be processed and visualized in various ways before being 
saved for future analysis.  

Central Main Window 

The Central Main window provides access to all functions, 
features, and settings within the Central Software Suite.  

Hardware Configuration  contains individual channel 
configurations as well as system settings. The main panel 
displays channels in icon or list view as selected in the tool bar. 
Double clicking selected channels will open the channel 
properties window for editing. Channels are filtered by clicking 
the categories listed on the left pane of the window. Additional 
settings are found under the Settings heading at the bottom of 
the left pane.  

Spike Panel displays detected spikes on the front-end amplifier 
channels in a grid-graph form and is often the fastest way to 
visualize overall system function. If spike-sorting rules are 
defined, the spikes belonging to different units will be displayed 
in different colors. Double click any channel to display the 
Single Neural Channel Window. 

Raster Plot displays the occurrence of spike events on many 
channels over time. All channel types may be shown in this 
window. Continuous traces and comments can also be shown 
on the plot.  

Single Neural Channel displays the selected channel in a 
continuous data trace, strip chart, and waves panel. Use this 
window to define spike sorting rules and to view single channel 
activity.  

Activity Map color codes the firing rate of neurons recorded by each electrode on a two-
dimensional grid. An electrode map file dictates the spatial arrangement of channels. 
Use this window to quickly visualize spike rates over all channels.  

File Storage contains the controls to start and stop recording. Additional settings, such 
as file type, name and path may be edited here.  

Signal to Noise Ratio displays the ratio of signal to noise for each channel. Use this 
window to view and record valuable information about signal quality and electrode 
functionality.  

Neural Modulation displays a histogram of changes in firing frequency over time. Use 
this window to see which channels are recording from neurons with variable firing rates.  

Thresholding allows the user to set a global spike detection threshold as a value or a 
multiplier of the root mean squared signal energy.  

 
Figure 4 ð Central Main Application 
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Impedance Tester measures and displays the impedance of each electrode. Use this 
window to assess electrode functionality.  

Crosstalk measures and displays the amount of signal shared between channels. Use 
this window to mark and disable redundant channels.  

N-Trode allows configuration and visualization of N-Trode groups. The Spike Display at 
the top of the window shows spikes on each channel.  The Peak/Valley panel is used to 
define spike units for the group. The Continuous Data Display shows the full signal from 
the group.  

Oscilloscope visualizes the signal acquired by any channel. Use this window to view, 
measure and compare signals with custom triggers. 

Digital Filter Editor is a MATLAB utility that creates custom digital filters which can be 
applied to acquired signals.  

Add Comment creates a time-stamped text comment which is included in the neural 
events (.nev) file.  

nPlay loads and replays saved data files for analysis and re-recording.  

System Load displays the volume of incoming data from the Neural Signal Processor. 

Menu Bar 

The menu bar is found at the top of the Central Main window and contains File, Tools, 
and Windows drop-downs. 

File 

The File menu contains functions to load 
and save various configuration files as 
well as the option to close applications 
and shut down the Neural Signal 
Processing hardware. 

Load System Settings: Load channel 
settings in the ó.ccfô and ó.rcfô formats. 

Load Sorting Rules: Load system-
calculated Histogram Peak Count sorting 
rules in the ó.csrô format. 

Load PCA Basis: Load system-
calculated principle component analysis 
basis vectors in the ó.cfsdô format. 

Load Digital Filters: Load digital filters 
in the ó.xmlô format created by the Digital 
Filter Editor. 

Save System Settings: Saves the 
channel settings currently set in 
Hardware Configuration. 

Save Sorting Rules: Saves spike-
sorting parameters. 

Save PCA Basis: Saves PCA basis vectors calculated during spike sorting. 

 
Figure 5 ð Central File Menu 
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Close Applications: Closes Central Suite programs while leaving the hardware 
running. 

Hardware Standby and Close: Closes Central Suite programs and puts 
hardware into standby mode. The system must be in standby mode for firmware 
updates. 

Hardware Shutdown and Close: Closes Central, all its associated applications 
and shuts down the Neural Signal Processor. Manually turn off the system power 
switch to complete hardware shutdown. 

Tools 

The Tools menu contains functions regarding thresholding, spike-sorting and 
general application settings. The spike sorting options are discussed on Page 23. 

Options 

Sets various general options for the Central Software Suite. 

 

Allow Multiple Instances Of  

Allows more than one instance of each checked window type to be 
opened.  

 

Sorting Log Rules 

Sorting rules are the manually or automatically defined spike unit 
classifications used to recognize and separate neural spike events.  

Do Not Log Sort Changes: Disables sort change logging. 

 
Figure 6 ð Central Options 
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Log Sorting Changes on óRecordô: Will automatically log the spike-
sorting model, the signal to noise ratio summary, and the crosstalk 
summary if rebuilt during recording. 

Log Sorting Changes óAlwaysô: Will log the spike-sorting model, the 
signal to noise ratio summary, and the crosstalk summary any time it is 
rebuilt. 

Log PCA coordinates on óRecordô: Will log the spike-sorting model only 
when recording begins. 

 

File Storage App Interface 

Choose to save files in the 2.x interface or the TOC interface. The TOC 
interface is designed to be used in a clinical setting where patient 
information is entered. The 2.x interface is preferable in a research setting 
where files are manually named. For more information of file types see 
Page 32. 

 

Single Neural Channel App Interface 

Allows changes to the channel configuration in Single Neural Channel 
viewer or in the Edit > Properties menu. 

 

Auto Impedance Interface 

Configures impedance testing for the Patient Cable or CerePlex 
headstages. 

 

Autoload System Settings 

Upon opening Central, the ó.ccfô file input below will be loaded. If the field 
is left blank, Central will prompt the user to select a ó.ccfô file. 

 

Windows  

The Windows menu contains system and software summary information as well 
as shortcuts to Central applications 

About: Displays the version of the software and the firmware of the system. 
These version numbers may be needed if you contact Blackrock support. 

System Summary: Displays average number of units per channel if using 
automatic histogram peak-count sorting. Options to disable cross talking 
channels and launch the impedance tester are also found here. 
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Hardware Configuration 
The Hardware Configuration panel contains individual channel configurations as well as system 
settings. The main panel displays channels in icon or list view as selected in the tool bar. 
Double clicking selected channels will open the channel properties window for editing. Channels 
are filtered by clicking the categories listed on the left pane of the window. Additional settings 
are found under the Settings heading at the bottom of the left pane.  

Channel Sorting 

Central Suite supports front end amplifier inputs, as well as analog, digital and 
serial inputs and outputs. Channels can be viewed in icon, list, or full row detail 
modes selectable in the tool bar on the toolbar. Each channel can be sorted 
based on function under Signal Types, or based on physical location under NSP 
Channels. 

Configuring Channel Properties 

Select one, or multiple channels in the right pane of the Hardware configuration window. 
Once all channels of interest are selected, right-click then select properties, or click the 
Channel Properties icon in the toolbar. Each channel type, and their respective options 
are described below. 

 
Figure 7 ð Hardware Configuration 
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Front End Analog Inputs 

All parameters for front end input channels are listed below.  

Label: A user-defined name for the 
specific channel. Multiple channels 
labels can be automatically assigned 

Digital Range: Fixed entry showing the 
range of digital values that analog 
signals are mapped to.  

Analog Range: Fixed entry showing the 
range of analog values measured. 

Analog Units: Unit of analog signal 
measurement displayed for reference. 

External Gain: Gain value of the 
headstage. All Blackrock systems use a 
gain of 1. 

Enable Line Noise Cancellation: Enables cancellation of 50 or 60 Hz noise. 

Estimate Time Constant: The period over which line noise parameters are 
determined. 

LNC Method: Selects software or hardware line noise cancellation. 

Filter: Select a digital filter to apply to continuous data.  

Graphical Chooser: Visualize the continuous signal filter in place.  

Sampling Rate: Select the sampling rate of data acquisition. 

Channel Chooser: Select the sampling rate for data acquisition on any channel. 

Raw Data: Record raw data stream before filtering or sorting is applied. 

AC Input Coupling: High pass filter to remove DC offset. 

 
Figure 8 ð Analog Input Properties 

 

 
Figure 9 ð Edit Multiple Labels 
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Software Reference Selection: Apply software referencing to local field 
potential or both Local field potential and spike data. 

Reference Electrode:  Select channel to use as software reference. 

Enable Spike Processing: Allow detection of spike events on channel. 

Filter: Filter selection for spike event processing. 

Graphical Chooser: Allows visualization of the spike processing filter in place. 

Threshold Value: Voltage threshold for classification of a spike event in mV. 

RMS Threshold: Set parameters for auto-threshold calculation. 

Sorting Algorithm: Set the sorting algorithm for a channel as described in Spike 
Sorting on Page 23. 

Enable Amplitude Rejection: Rejects waveforms exceeding a specified 
amplitude. 

Upper/Lower Limit (uV): Voltage limits for amplitude rejection. 

Analog Output 

Analog output properties are accessed from the left side bar of the Hardware 
Configuration window and allows the user to set the properties of the analog 

 
Figure 10 ð Filter Properties 
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output ports.  Analog outputs can function as monitor channels, directly mirroring 
signals of interest, or as waveform generators. Each modality has output and 
triggering parameters defined below. 

Label: User-defined channel label. 

Function: Assigns the analog channel function.  

Analog Output: Continuous Monitor 

An analog output channel configured as a continuous monitor will scale a user 
input signal into a plus or minus 5 V output signal.  

Input Range: Input voltage range displayed for reference. 

Output Range: Output voltage range displayed for reference. 

Track Most Recently Selected: When enabled, the channel selected in Spike 
Panel, Single Neural Channel, or Raster Plot view is used as the monitor input. 

Channel: An analog output channel configured as a spike monitor will scale a 
user selected input signal into a plus or minus 5 V output signal. 

Analog Output: Spike Monitor 

An analog output channel configured as a spike monitor will scale a user 
selected input signal into a plus or minus 5 V output signal containing only 
identified spike events. 

Input Range: Input voltage range displayed for reference. 

Output Range: Output voltage range displayed for reference. 

Track Most Recently Selected: When enabled, the channel selected in Spike 
Panel, Single Neural Channel, or Raster Plot view is used as the monitor input. 

Channel: An analog output channel configured as a spike monitor will scale a 
user input signal into a plus or minus 5 V output signal containing only identified 
spike events.  

 

 
Figure 11 ð Analog Output: Continuous Monitor 
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Analog Output: Sine Waveform 

An analog output channel configured as a sine waveform generator will produce 
a user defined sine wave on a user defined trigger stimulus.  

Amplitude (mV): Amplitude of the output sine wave. 

Frequency (Hz): Frequency of the output sine wave. 

Offset (mV): DC offset of the output sine wave. 

Wave Number: Select which of five waveforms are configured and used. 

Trigger: Triggering options are explained on Page 18. 

Analog Output: Custom Waveform 

An analog output channel configured as a custom waveform generator will 
produce a user defined waveform on a user defined trigger stimulus. 

Wave Number: Select which of five waveforms is configured and used. 

Number of Phases: Number of voltage phases in the waveform. 248 are 
available. 

Offset (mV): DC offset of the waveform. 

Phase: Selects which phase is being configured. 

Amplitude (mV): Phase amplitude. 

Duration (ms): Phase duration. 

Repeats: Indicates the number of times to repeat the waveform once triggered.  
A value of 0 will repeat the waveform indefinitely.  

 

 
Figure 12 ð Analog Output: Sine Generator 
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Analog Output: Triggering 

Sine and custom waveforms can be triggered by different conditions listed below. 

Instant: Waveform triggers when OK or Apply are clicked. 

Digital Input Rising Edge: Waveform triggers when a user defined digital input 
pin transitions from low to high.  A digital input bit must be selected. 

Digital Input Falling Edge: Waveform triggers when a user defined digital input 
pin transitions from high to low.  A digital input bit must be selected. 

Spike Unit: Waveform triggers when a sorted unit is detected on a defined 
channel.  

NeuroMotive ROI: Triggers when a subject enters or exits a selected region of 
interest. 

Extension: Waveform triggers based on custom extension code loaded onto 
hardware. 

Digital Input 

Digital input properties are accessed from the left side bar of the Hardware 
Configuration Window and allows the user to set the properties of the digital input 
ports. Digital inputs can synchronize external hardware and pass digital data into 
neural recordings. Digital Inputs may take on the functions listed below.  

16-bit on word strobe: Reads 16 bits on the rising edge of the strobe pin. 

 
Figure 13 ð Analog Output: Custom 
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16-bit on bit changes: 16-bit read when any bit changes from LOW to HIGH or 
from HIGH to LOW. 

16-bit on rising edge: 16-bit read when any bit changes from LOW to HIGH. 
Each bit indicates if a LOW to HIGH change occurred on each digital pin. 

16-bit on falling edge: 16-bit read when any bit changes from HIGH to LOW. 
Each bit indicates if a HIGH to LOW change occurred on each digital pin. 

8-bit strobe / 8-bit bit changes: Reads bits 0-7 on the rising edge of the strobe 
pin and reads bits 8-15 if bits 8-15 changed from LOW to HIGH or HIGH to LOW. 

8-bit strobe / 8-bit bit rising edge: Reads bits 0-7 on the rising edge of the 
strobe pin, and bits 8-15 indicate if digital pins D8-D15 changed from LOW to 
HIGH. 

8-bit strobe / 8-bit bit falling edge: Reads bits 0-7 on the rising edge of the 
strobe pin, and bits 8-15 indicate if digital pins D8-D15 changed from HIGH to 
LOW. 

Digital Output 

The Digital Output Window is accessed from the left side bar of the Hardware 
Configuration Window and allows the user to set the properties of the digital 
outputs. Digital outputs can function as spike detection monitors, timed function 
generators, or triggered events.  

Digital Output: Monitor Electrode 

A digital output in monitor electrode mode will send a high pulse when a sorted 
spike unit is detected on a defined channel. 

Track Most Recently Selected: When enabled, the channel selected in Spike 
Panel, Single Neural Channel, or Raster Plot view is used as the monitor input. 

Source: Select which channel to monitor. 

Monitored Units: Select which spike unit classifications to trigger on. 

 

 
Figure 14 ð Digital Output Properties 
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Digital Output: Timed 

A digital output in timed mode will send a pulse train with specified parameters. 
The signal can be configured by setting frequency and duty cycle, or samples 
high and low.  

Frequency (Hz): The number of pulses per second. 

Duty Cycle: The percentage of time a pulse train is high. 

Samples High: Number of 30kHz sample periods output should be held high.  

Samples Low: Number of 30kHz sample periods output should be held low.  

Offset (mV): DC offset voltage of the digital output. 

Digital Output: Triggered 

A digital output in triggered mode will send a pulse when the selected trigger 
stimulus occurs.  

Digital Input Rising Edge: Waveform triggers when a user defined digital input 
pin transitions from low to high.  A digital input bit must be selected. 

Digital Input Falling Edge: Waveform triggers when a user defined digital input 
pin transitions from high to low.  A digital input bit must be selected. 

Spike Unit: Waveform triggers when a sorted unit is detected on a defined 
channel.  

NeuroMotive ROI: Waveform triggers when a subject enters or exits a region of 
interest. 

Extension: Waveform triggers based on custom extension code loaded onto 
hardware. 

Serial I/O 

The Serial I/O Properties window 
displays the serial communication 
parameters and allows the user to 
name and enable the serial port.  Serial 
communication parameters cannot be 
changed. 

 
 
 
 
 
      
 
 
 
 
 

 
Figure 15 ð Serial I/O 
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Settings 

Global Settings 

Spike Width (samples): The number of samples recorded around a detected 
spike event.  

Pre-threshold Samples: The number of samples to record preceding a 
threshold crossing.  

Line Noise Frequency (Hz): The line frequency of the system, either 50 Hz or 
60 Hz.  

LNC Reference Channel: The reference channel used to compute system line 
noise. The extracted line noise template for each channel can be viewed in 
Single Neural Channel when the Raw/LNC button is checked. 

  
 
 
 
 
 
 
 
 
 
 

 
Figure 16 ð Hardware Configuration Settings 
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Filters 

This window displays the details of a selected digital filter in a bode plot and key 
numerical parameters.  

Auto Thresholding 

This window allows the user to specify the auto thresholding properties for spike 
detection.  

Threshold Multiplier: To register as a spike event, signal energy between 1 and 
5 kHz must exceed the energy of the noise by a factor of the threshold multiplier 
level. 

Channel: Applies noise boundary properties to this channel. 

Dimensions of the Ellipsoid: Radius of the noise ellipsoid in the along each 
axis. 

Center of Ellipsoid: Center of the noise ellipsoid in cartesian coordinates. 

Rotation of Ellipsoid: Rotation angle of the noise ellipsoid around each axis. 

 

 
Figure 17 ð Filter Properties Display 
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Spike Sorting 

The Spike Sorting Properties Window allows the user to specify the rules and 
settings for the spike sorting algorithms. The default settings are recommended 
but altered settings may produce better results in unique use cases. Four spike 
sorting methods are available: Manual PCA, k-means PCA, DBSCAN PCA, and 
Histogram Peak Count. Each method is described below. 

Manual PCA 

Manual PCA uses principle component analysis to generate a feature 
point for each spike event.  The user manually defines unit classifications 
by drawing an ellipsoid around each cluster of feature points within the 
feature space. 

Wave Basis Size: The number of waveforms to use to calculate the PCA 
basis vectors.  

Update Basis Multiplier: The PCA basis vectors will be recalculated 
after the number of samples exceeds the basis size times the basis 
multiplier. Zero means donôt recalculate. 

 

k-means PCA 

k-means PCA algorithms automatically generate ellipsoids around k 
number of clusters to sort recorded units.  

Wave Basis Size: The number of waveforms to use to calculate the PCA 
basis vectors.  

Update Basis Multiplier: The PCA basis vectors will be recalculated 
after the number of samples exceeds the basis size times the basis 
multiplier. Zero means donôt recalculate. 

Outlier Removal: Removes outliers exceeding this number of standard 
deviations from the centroid of each group. 

Minimum Group Size: Remove any groups that have fewer than this 
number of spikes. 

Merge Centroids: Merge two groups if the merged group has a standard 
deviation less than this multiplier times the product of the standard 
deviations of both groups. 

Number k-means groups: Number of k-means groups to use for sorting. 

 

DBSCAN PCA 

Density Based Spatial Clustering of Applications with Noise is a principle 
component analysis method that automatically chooses the quantity, 
radius, and position of each cluster based on point density. 

Wave Basis Size: The number of waveforms to use to calculate the PCA 
basis vectors.  
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Update Basis Multiplier: The PCA basis vectors will be recalculated 
after the number of samples exceeds the basis size times the basis 
multiplier. Zero means donôt recalculate. 

 

Histogram Peak Count 

Collected waveforms are broken down into high frequency and low 
frequency components. Each spike event is plotted on an axis composed 
of these two components. A histogram is constructed and clusters are 
estimated by determining peaks and valleys. 

Valley Percentage: A valley is identified at a height less than the first 
peak height times the valley percentage value. 

Close Peak Percentage: The second peak is identified at the height of 
the valley plus the height of the three-point mean centered at the valley 
multiplied by the close peak percentage. 

Freeze Time (minutes): Time spent analyzing the number of units on 
each channel. 

Update Rate (# spikes): The number of spikes that must be collected 
within each unit before the histogram is updated. 

Minimum Peak Percentage: Minimum peak height is calculated by 
adding the valley height to the total number of samples used times the 
minimum peak percentage. 

 

Artifact Rejection 

Maximum Simultaneous Channels: If more than the maximum number 
of channels contain simultaneous spike events, the events are all 
rejected. 

Refractory Period: The number of samples for which spike detection is 
barred after a spike event. 

 
Figure 18 ð Spike Sorting Properties 
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Tools Menu 

The main Central Window Tools menu 
contains several Spike Sorting options. 

Thresholding: Set the manual threshold 
level for all channels as an RMS multiplier or 
a fixed voltage value. 

Options: See below. 

Lock Unit Statistics: Disables continuous 
updates of spike sorting rules. 

Rebuild Spike-sorting Model: Restarts the 
automatic spike-sorting function. 

Continuous Spike Sorting: Selecting this 
item will continuously adjust the spike-sorting 
statistics including the splitting and merging 
of units. This is not recommended for use 
while recording.  

Build PCA: Builds the PCA basis vectors for 
all channels with PCA based spike sorting. 

Assisted Spike Sorting: Enable k-means, 
DBSCAN, or all PCA methods for spike 
sorting.  

Adaptive Filtering 

Recorded signals may contain unwanted information from sources of external 
noise, such as magnetic eye-tracking systems, monitors, and subject reward 
systems. The Adaptive Filtering feature can use a noise signal as a reference for 
neural signal channels.  

Adaptive Filtering: Choose one or two channels to reference. 

Reference Channels: Select channels to be used as references. 

 
Figure 19 ð Tools Menu 

 

 
Figure 20 ð Adaptive Filtering 

 



 

Revision 5.00 / LB-0574 ï Research Central Software Suite: Instructions for Use 
© 2019 Blackrock Microsystems, LLC  26 

N-Trode Groups 

N-Trode channel groupings are user defined electrode subsets created to record 
signals from proximal regions. When any single unit spike is detected within the 
N-Trode, the signals from all component electrodes are saved and registered as 
events. The Central Suite supports multiple N-Trode sets containing up to four 
electrodes each. Multiple single channels are linked and spike sorting occurs on 
the N-Trode as a single entity. To define N-Trode groups, open a group and add 
channels to it with the arrow buttons or by double clicking.  

  

 
Figure 21 ð N-Trode Properties 
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Spike Panel 
Spike panel displays detected spikes on the front-end amplifier channels in a grid-graph form 
and is often the fastest way to visualize overall system function. Double click any channel to 
display the Single Neural Channel window. The layout and graphical settings of the grid and 
individual channels can be changed in the right-click menu or the toolbar. A map file can be 
applied to the display to change the spatial arrangement of the channels on the screen to match 
the electrode array in use. If spike-sorting rules are defined, the spikes belonging to different 
units will be displayed in different colors. 

Spike Panel Settings 

 Load Map File: The default map file for the spike panel is a 16x8 grid. Custom map 
files matching the spatial arrangement of your electrode ship with each Blackrock 
Electrode Array. Contact Blackrock Support at support@blackrockmicro.com for an 
additional copy of this file. 

Load Default Map File: The default channel map will be loaded. 

 
Figure 22 ð Spike Panel 
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 Map File Information: Display information about the current map file. 

 Time to Screen Refresh: Set the length of time spike waveforms will trace 
without refreshing. 

 Open Selected Channels: Individual or groups of channels can be viewed by 
selecting Open Selected Channels in the right-click menu or the top menu bar. 

Show Labels: Display channel information on the cursor.  

 Refresh Screen: Manually refresh the spike panel display. 

 Magnify Current Channel: Toggle mouse-hover magnification 

 Spike Scale: Adjust the visual amplitude of displayed spikes. 

 Broadcast Channel Selections: Duplicate channel selection on other instances of 
Central running on computers connected to an Ethernet switch. 

 Level of Criticality: Display the current application load. 

 

Raster Plot 
The Raster Plot displays the occurrence of spike events on many channels over time. All input 
channel types may be added, removed, moved, and scaled in this window. Continuous traces 
and comments can also be shown on the plot. 

Tool Bar 

 Play: Configure the display to fill and then refill repeatedly.  

 Scroll: Configure the display to scroll right to left. 

 Pause: Pause the display. 

 Increase/Decrease Font Size: Change the font size of channel labels. 

 One Line per Channel: Display all units from each channel on one line.  

 Split Channels: Display each unit on a separate line. 

 
Figure 23 ð Raster Plot 
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 Seconds per Division: Change the time scale markers on the plot. 

 Decrease/Increase Size: Change the size of selected channels. 

 Minimize/Maximize Size: Minimize or maximize the size of selected channels. 

 Delete: Remove selected channel from the plot. 

 Move Up/Down: Move selected channels through the channel list.  

 Continuous Data Scale: Set the amplitude of continuous signals. 

 Show Neural Events: Display neural events as impulses on the raster plot. 

 Show Continuous Data: Display continuous channel trace. 

 Raw Toggle: Toggle between filtered continuous and raw data. 

 Update: Refresh the display. 

 Sort: Sort channels in the raster plot display by Channel ID, Recording Mode, or Unit 
ID. 

 Choose Channels: Select channels to display. 

 Add All: Display all channels. 

 Clear All: Remove all channels from display. 

 Open Selected Channels: Open selected channels in Single Neural Channel. 

 Broadcast Channel Selections: Duplicate channel selection on other instances of 
Central running on computers connected to the Ethernet switch. 

 Level of Criticality: Display the current application load.   
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Single Neural Channel 
Single Neural Channel visualizes the selected channel in a continuous data trace, strip chart, 
and waves panel. Spike sorting is configured in this window.  

Channel Configuration 

 Channel ID: Select a channel from the drop-down menu. 

 Channel Selector: Scroll through channels.  

 Channel Properties: Open the Channel Properties window. 

 Persist Spikes: When selected, the last detected spikes will remain in the wave 
viewer for sorting. 

 View Tool Tip: Display time and amplitude values at the cursor position. 

 View Continuous: Toggle the Continuous Data Display. 

 View Classification: Toggle the Online Classification Display. 

 Broadcast Channel Selections: Duplicates channel selection on other instances of 
Central running on computers connected to the Ethernet switch. 

 

 
Figure 24 ð Single Neural Channel 
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Spike Display 

The spike display panel shows neural events. It contains the wave panel where spikes 
can be visualized and sorting hoops can be defined, as well as the strip chart. Use the 
vertical slide button at the right of the panel to set the voltage range. The default time 
scale of the spike display window is 1.6 milliseconds. The samples width of each spike 
can be defined in the Global Settings section in the Hardware Configuration module 
within a range of 1.0 to 4.3 milliseconds. 

Clear: Clear the spike display. Automatic clearing will occur as well, maintaining the 
number of spikes shown in the drop-down menu. 

Show Spikes: Select which spike units to display. 

Hoops Spike Sorting: To define a spike unit, click Define next to a unit window box on 
the right side of the window. A color box will appear in the lower right of the spike 
window. Drag the selector to include all contacted waveforms in the unit. Only 
waveforms within a selection will be classified. The Define All button will initialize all five 
units. 

Unit Mapping: Select unit definitions to remap, combine, or map to noise. 

3D PCA On-line Spike Classification: If manual PCA is selected, spike sorting is 
performed using online PCA analysis within the PCA space. PCA spike sorting can 
classify up to five different signals per channel, each selected signal receives a separate 
color. An ISI Histogram is also displayed for each classified spike.  

A user can sort an individual channel by clicking on the Feature tab. Click the Define 
button next to the classified spike to sort that unit. Hold the Ctrl key and draw around the 
cluster. An ellipsoid will be created which is used to define a unit. You may also change 
the size of the ellipsoid by pressing R then moving the handle. 

k-means & DBSCAN PCA:  Generates ellipsoids when the k-means or DBSCAN PCA 
is selected in the Feature tab. 

Manual Override Options 

Automatic spike sorting can be overridden on an individual channel by clicking on the 
Pattern view. Click the Edit button next to the classified spike to resort to a manual 
sorting option. Press <C> to see all available controls. Hold down the <Ctrl> key and 
draw an ellipse in the Pattern view around the cluster that you would like to define as a 
spike. You may also change the diameter of the ellipse. Once the ellipse is placed 
around a cluster of points. The word ñOverriddenò will appear next to the sorted unit.  
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File Storage 
Central Software Suite supports file storage via the TOC and 2.x interfaces. 2.x is the most 
common basic file interface for research. The TOC interface names files with a timestamp and 
patient name, as well as file splitting long recordings. Data files are saved in .nsx format. .nsx 
data is stored in bits with 250 nV/bit resolution. Timestamps appended to filenames by Central 
use Greenwich Mean Time (GMT) referencing your local computerôs clock and time zone 
information. 

TOC Interface 

The TOC interface allows the user to enter patient information and select a path for the 
files that are created when the session is initiated. The Central Software Suite assigns a 
numeric name to the files which indicates the date and time of the recording. For 
example, 20110124-152145 indicates that the data file was recorded on January 24, 
2011 at 3:21:45 PM GMT. System settings will be saved in the same folder as the data 
file. 

File Splitting: Splitting large files into smaller sizes may aid offline analysis. File size 
limit is defined in the View > Options menu. To disable file splitting, check the disable 
file-splitting box in the file storage module. 

File Description: Up to 256-character comments can be entered here to be saved with 
the file. Comments need to be entered prior to recording a data file. 

Record For: Specify an amount of time that the Central Software Suite will record data. 
Once the time has expired, the recording will stop automatically. 

Remote Recording Control: Allows digital in signals to Start, Stop, Pause, and Resume 
file recording through the digital input port, or the serial I/O port. Click the Setup button 
below the remote recording check box to set user-defined hex values for each remote 
recording function. For an example of remote recording control see Page 50. 

 
Figure 25 ð TOC Interface 
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Record: Begin recording data. 

Pause: Pause recording. 

Stop: Stop recording and save file. 

 

2.x Interface 

The 2.x interface allows the user to specify a file name and path for the next data set. 
Recording can be started and stopped from this window or set to stop after a specified 
duration. 

File Options: Select sampling frequency of recorded data. 

File Name and Path: Browse to, or type in, the desired file name and path. 

Auto-Increment: Enable automatically incrementing the data file names with an 
appended numeral. 

File Specification: Choose between the different file specifications. It is advised to 
always use the most current specification. 

File Storage Options 

After opening the File Storage Window, options can be found under View menu.  

Enable Sync Pulse: Send a unique waveform pattern every 14 seconds and 
repeat patterns hourly.  

Invert Sync Pulse: Invert the high and low phases of the sync pulse. 

Remove Noise: Do not save waveforms classified as noise during spike sorting. 

Sync with NeuroMotive Recording: Enable syncing with the NeuroMotive video 
recording and tracking system. 

Split File Interval: Enter either a duration or file size limit for each file segment. If 
file size is specified, click on ñCalculate Timeò to automatically populate the 
ñEstimated Timeò field. 

 

 
Figure 26 ð 2.x Interface 
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Digital Oscilloscope 
The digital oscilloscope can display and measure two input channels on screen at a resolution 
of 0.1 milliseconds per division. Signals can be viewed continuously or on a specified trigger. 
Frequency spectra can also be displayed. 

Channel Enable: Two channels may be viewed per instance of the oscilloscope. 

Channel Selection: Select any channel from the drop-down menu. 

Color Selection: Select a color for either trace. 

Settings: Open the properties window for the selected channel.  

Invert: Invert the trace for a given channel. 

Trace Amplitude: Modifying the sliders for each channel will 
change the signal amplitude. The top slider changes the range 
and the lower slider selects a value within the given range.  

Time/Frequency selection: Set the oscilloscope into time or 
frequency mode. 

Time Resolution: Modifying the sliders will change the time 
resolution of the trace. The upper sliders change the range of 
resolution and the lower slider is used to choose a value within 
the given range. 

 

 
Figure 27 ð Digital Oscillloscope View 

 
Figure 28 ð Trace Amplitude 

 


































